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Introduction

Introduction
Learn-by-Doing: Microsoft Office Specialist Word 2019

As the name implies, the Learn-by-Doing Series gets students learning Microsoft Office 
2019 by using its applications to communicate and share information in the real world 
of work and life. This book uses step-by-step instructions and illustrative screenshots 
to introduce and reinforce essential skills needed to produce a variety of documents 
in Word 2019. In addition, students will practice all the skills assessed on the Microsoft 
Office Specialist Word Associate 2019 Certification Exam. 

Designed for today’s interactive, visual learner, this text consists of graphical hands-on 
lessons that get students instantly engaged in applying Microsoft Word 2019 skills. 
Students will learn how to format text and paragraphs, work with tables, and design 
sophisticated multi-page documents as they explore the powerful features and 
interface of Word 2019. 

Microsoft Office Specialist (MOS) Certification
Microsoft Office Specialist (MOS) is an industry-leading certification designed to 
assess mastery of Microsoft Office applications. Candidates are evaluated on their 
ability to apply their knowledge of important Microsoft Office features in a project-
based environment. Certified Microsoft Office Specialists demonstrate internationally-
recognized skills that can be leveraged for future success in both the classroom and 
the workplace. To support students seeking MOS certification, this text provides 
detailed instruction in all of the skills assessed on the MOS Word Associate 2019 
Certification Exam.

Benefits of Using This Textbook
Learn-by-Doing: Microsoft Office Specialist Word 2019 is designed to be used by 
students enrolled in a word processing computer applications course, as well as 
by learners looking to expand their knowledge of Microsoft Word 2019 for MOS 
certification. Students should have a basic familiarity with working on a computer. 
Microsoft Word skills and features are presented in order, ranging from basic to 
intermediate. The lessons in this book reinforce and build upon knowledge as it is 
acquired; therefore, lessons should be completed in the order presented.

Throughout these lessons, you will also gain hands-on experience with all the 
skills needed to pass the MOS Word Associate 2019 Certification Exam. MOS 
certification can help boost confidence in your ability to use the key features of 
Word 2019 you may encounter in the workplace and beyond. MOS certification 
can also be a valuable asset when applying for jobs, helping you demonstrate 
experience and proficiency in essential workplace productivity  
principles, including communication and collaboration.
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Styles Pane: 
Use this pane to reveal the 
Style names and a preview of 
recommended Styles for your 
document.

Style Inspector: 
Use this icon to view the text’s formatting 
based on the Style, plus any additional 
formatting applied to that Style. 

Link: 
Use this option to link text to 
another place within a document 
or to a website.

Style Sets : 
Use this drop-down menu to apply a new set of fonts and 
paragraph formats to a selection of text.

Lesson 3.10

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery lessons for this part.

Skills
�� Use the Style Inspector

�� Insert hyperlinks

 � Apply style sets 

Part 3: Formatting Paragraphs & Editing Text 

Kids Who Code 
Meeting Minutes 2
Applying Hyperlinks to Text

Lesson Overview
Working with another person’s documents has its challenges. One of the 
biggest challenges is making formatting changes to a document that has 
been previously formatted. Upon first glance, it is not always easy to see 
what style someone used for text formats and, if you are trying to keep 
things consistent, this information is necessary. The Style Inspector is a 
feature that allows you to see the font style, size, color, and other formats 
to a selection of text, and it can help you seamlessly work with documents 
created by other users. The Style Inspector will confirm the changes that 
were made to text as you recall the styles you applied. Style sets allow you 
to change the look of a selection of text with preset font and paragraph 
formats that coordinate well with one another.

In this lesson, you will retrieve the previously created meeting minutes document, 
review the formatting styles that were applied, and hyperlink text to a computer 
science website.

90 Learn-by-Doing: Microsoft Office Specialist Word 2019

1. Launch Word 2019 and open the file named 3.9 Kids Who Code Meeting 
Minutes from your My Word Projects folder on your hard drive or network 
drive.

2. Save the file as 3.10 Kids Who Code Meeting Minutes 2 in your My Word 
Projects folder on your hard drive or network drive.

3. Select the title text of the document [Kids Who Code Meeting Minutes].

4. From the Home tab, Styles group, do the following:

a. Launch the Styles pane.

b. Click the Style Inspector icon to view the formatting styles for the selected 
text. 

c. Close the Style Inspector and Styles panes.

5. Select the text [computer science website] in the second paragraph of the 
[New business] section and do the following:

a. Right click and select Link.

b. In the Address field of the Insert Hyperlink dialog box, enter the website 
address [www.computersciencezone.org], then click OK (as shown below):

 Hint: Use CTRL + Click to test the link to the website, then close your browser.

4b.

5a.

4c.

Applying Hyperlinks to Text Lesson 3.10

4. 4a.

Instructions

91Part 3: Formatting Paragraphs & Editing Text

Lesson Overview
Explains the skills and 

concepts that will be learned 
in the lesson and provides 

context for their use in a 
particular document.

Tools & Terms
Illustrates the icons and 

menu descriptions used to 
complete the lesson. 

Skills
Lists the new skills introduced in the lesson. Skills assessed in 
the MOS Word 2019 Certification Exam are identified with a red 
bullet. To provide comprehensive instruction, foundational and 
supporting skills are also identified.

Instructions & Screenshots
Instructions that are illustrated with corresponding drop-down menus and dialog 
boxes are indicated by a red  #   icon. Match each instruction with its corresponding 
screenshot as you complete the step.

 �Note: Once a new skill has been presented, visual step-by-step instructions for that 
skill are no longer provided in subsequent lessons.

 �Note: Office 365 is a suite of web-based applications; updates and changes happen 
regularly. At the time of going to press with this textbook, every attempt was made 
to reflect accurate screenshots and include tasks and skills that can be accomplished, 
with minor modifications, despite any updates that may occur.

Lesson Title

Introduction

Understanding the Format of This Book
This book is divided into nine parts, each containing individual lessons pertaining to 
the principal tools in each tab of Microsoft Word 2019. Lessons in this book have been 
organized into an easy-to-read, self-guided, visual format where you encounter and 
practice new skills and learn by doing. Some lessons require access to source files to 
complete the instructions and should be provided by your instructor.

Review the following features and components to become familiar with the structure 
of the lessons in Learn-by-Doing: Microsoft Office Specialist Word 2019.

iv Learn-by-Doing: Microsoft Office Specialist Word 2019For Evaluation Purposes Only



6. Select all of the text in the document and change the line spacing to single with 
no additional space before or after paragraphs.

7. From the Design tab, Document Formatting group, More drop-down menu, 
Built-In styles, select Basic (Simple) (as shown below):

8. Proofread your document for accuracy and format, then resave the file.

9. Print preview. Your document should look similar to Figure 3.10. 

10. Print or share the document if required by your instructor.

7.

Lesson 3.10 Applying Hyperlinks to Text

92 Learn-by-Doing: Microsoft Office Specialist Word 2019

Kids Who Code Meeting Minutes 
 
Call to order 
A meeting of Kids Who Code was held at Pleasant Valley High School in the student lounge on 
December 1, 20xx. The meeting was called to order at 3:30 pm. 
Attendees 
Present: Lisa Harris, Shawn Duncan, Preston Briggs, Erika Robertson, Ella May  
Members not in attendance: Velma Harrison, Hugo Craig 
Approval of minutes 
A motion to approve the minutes of the November meeting was made by Shawn and seconded 
by Erika. All in favor. 
Treasurer’s report 
Preston Briggs, Treasurer, reported that the Kids Who Code bank account currently has 
$1,873.33. Our next fundraiser is projected to raise $2,500. No new expenses are planned as of 
now. 
New business 
President Lisa Harris made a motion to begin planning for the celebration of senior club 
members. Her idea is to host a game night in their honor sometime in May. This night will be 
open to the entire student body and held in the student lounge. Donations will be accepted. A 
refreshments committee should be formed. The motion was seconded by Ella. All in favor. 
Member Ella May reported about the recent volunteer work a few of the members were 
involved in. Five club members were asked to assist elementary school teachers with 
presentations on careers in computer science. They used information from a computer science 
website. The help was very much appreciated and well received by the kids. It is very likely the 
club will be asked to present on more computer related topics during the school year. 
Announcements 
Member Erika Roberts announced that she will be moving to another school district at the end 
of this school year. Her parents have decided to downsize and sell their house in town. We wish 
Erika lots of luck at her new school where she will, no doubt, join the computer club. 
Next meeting 
Our next meeting will be held on January 14 at 3:30 pm in the student lounge. 

Figure 3.10

Lesson 3.10Applying Hyperlinks to Text
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Part 5 
Skills Mastery Quiz 5.1 

Skills 
• View the Ruler 
• Use the default tab 
• Set tabs using the ruler 
• Convert text to tables 

• Set tabs using the dialog box 
• Use dot leaders 
• Convert tables to text 
• Clear tabs 

Instructions 
1. Using Word 2016, open the file named Skills Mastery 5.1 SOURCE. 

2. Save the document as Skills Mastery 5.1 Your Name to your local or network hard drive. 

3. Display the ruler. 

4. Indent the title [2010 MOVIES BY WORLDWIDE GROSS] .5”. 

5. Convert the text under the title [2010 MOVIES BY WORLDWIDE GROSS] to a table with 3 columns 
and 11 rows. 

6. Convert the table under the title [ALL-TIME HIGHEST GROSSING ANIMATED FILMS (in Billions)] to 
text separated with tabs. 

7. Key 2 blank lines after the last row of text, then clear the tabs. 

8. Key the text [2016 ANIMATED FILMS] bold and center aligned. 

9. On the next line, set the following tabs: 

a. Left tab at 2” 

b. Decimal Tab at 4.5” 

10. Key the following text, with a tab between the movie title and dollar amount: 

Finding Dory $1.03 

Zootopia  $1.02 

11. Carefully proofread the document, then resave the file. 

12. Print or share the document with your instructor. 

Introduction

Skills Mastery
Upon completion of all the lessons in each part, your 
instructor may require you to complete a series of 
Skills Mastery Quizzes. These quizzes offer you the 
opportunity to demonstrate mastery of new skills and 
assess your knowledge of the essential features of 
Microsoft Word 2019.

Skills Mastery Quizzes for each part are located with the 
Instructor Resources.

Figure
Provides the content to 
be used in the lesson. 
Figures can also be used 
as visual guidance to assist 
in producing the finished 
formatted document.

Ribbon
The primary Microsoft Word 2019 tab being used in the lesson is displayed 
at the top of the Instructions page. Red  #   icons illustrate the group being 
used to complete a particular skill.

vIntroduction For Evaluation Purposes Only



Lesson Skills

Approximate  
Completion Time 

(in hours)

Part 1:  Document Basics

1.1 Oh, the Places 
You’ll Save! 

Exploring Places to Save 
Work

 Use File Manager  Create a folder  Log in to 
OneDrive  Sync to OneDrive 

.5

1.2 Getting Started Navigating Word  Create a blank document  Understand 
Backstage View  Identify tabs and groups  
 Change document views  Customize views 
by using zoom settings  Close Word

.75

1.3 Start of the Year 
Goals

Creating Your First 
Document

 Create a blank document  Customize views 
by using zoom settings  Save a document to 
a local hard drive or network drive  Close a 
document 

.75

1.4 Start of the Year 
Goals 2

Retrieving a Document  Open an existing document from your hard 
drive or network drive  Revise an existing 
document  Print a document  Modify print 
settings  Use Save As  Save documents in 
alternative file formats

.5 - .75

1.5 Believe Me Ideas Emailing a Document  Share documents electronically - email .75

1.6 How to Get There Editing Basics  Cut, copy, and paste text .5

1.7 What Kind of 
Learner Am I?

Customizing the Quick 
Access Toolbar

 Use Undo and Redo  Customize the Quick 
Access toolbar  Use the Tab key to indent 
paragraphs

.75 - 1

1.8 You Are So Smart Getting Help and 
Information

 Use Search  Insert a cover page  Use Smart 
Lookup  Locate and remove hidden properties 
and personal information  Modify basic 
document properties

.75

1.9 My Action Plan Working with PDF File Types  Open a PDF in Word for Editing .5

Part 1 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Part 2:  Formatting Text

2.1 Decades of Slang Formatting Text  Apply font formatting  Clear formatting .75

2.2 Top 10 Formulas Enhancing and Formatting 
Text

 Format paragraphs as numbered lists  Apply 
font formatting  Insert symbols and special 
characters

.75

2.3 Back to School BBQ Formatting Text with Effects  Apply text effects  Apply a text highlight 
color  Apply formatting by using Format 
Painter

.5 - .75

2.4 What’s Cooking Enhancing Proofreading 
Skills

 Replace text by using AutoCorrect  Remove 
a word from AutoCorrect  Show and hide 
formatting symbols and hidden text

.75

Part 2 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Curriculum Guide
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Lesson Skills

Approximate  
Completion Time 

(in hours)

Part 3:  Formatting Paragraphs & Editing Text

3.1 Spirit Team Promo Changing Paragraph Line 
Spacing

 Set line and paragraph spacing and 
indentation  Show and hide formatting symbols

.75

3.2 Homecoming 
Weekend  
Invitation

Applying Text Alignment  Use a soft return  Use a hard return  Change 
text alignment  Add borders

.5 - .75

3.3 There’s an App for 
That

Using Indents and Paragraph 
Spacing

 Set line and paragraph spacing and 
indentation

.5

3.4 I’m So Bored! Creating Lists  Format paragraphs as numbered or bulleted 
lists  Increase and decrease list levels  Set 
starting number values  Restart list numbering 
 Change bullet characters and number formats 
 Define custom bullet characters 

1

3.5 Top Vacation Spots Working with Numbered 
Lists

 Define custom number formats  Increase and 
decrease list levels  Restart and continue list 
numbering

.75

3.6 A-Z Guide for 
School Success

Applying Background 
Shading and Sorting Text

 Sort paragraph text  Shade background of 
text

.75

3.7 Letter to an  
Incoming  
Freshman

Using Find and Replace  Find and replace text  Find and replace text 
formatting

.75

3.8 Something Like 
That

Proofing Your Document   Use the Editor  Use the Thesaurus  Use Word 
Count  Use Character Count

.5 - .75

3.9 Kids Who Code 
Meeting Minutes

Applying Text Styles  Apply built-in styles to text  Create and save 
a style

.75

3.10 Kids Who Code 
Meeting Minutes 2

Applying Hyperlinks to Text  Use the Style Inspector  Insert hyperlinks  
 Apply style sets 

.5

3.11 Travel Help Translating Text  Translate a selection  Translate an entire 
document  Insert translation results into a 
document

.75

Part 3 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Part 4:  Working with Tables

4.1 Midterm Exam 
Schedule

Using Table Basics  Create a table by specifying rows and columns  
 Change cell alignment  Resize rows and columns

.5

4.2 Midterm Exam 
Schedule 2

Working with Rows, 
Columns, and Cells

 Vertically center a table on a page  Insert and 
delete rows, columns, and cells  Merge and 
split cells

.5

4.3 City Life Formatting Tables  Shade cells, rows, and columns  Apply 
borders  Configure cell margins and spacing  
 Resize tables

.5

4.4 City Life 2 Enhancing Tables with 
Styles

 Apply table styles  Modify table styles .5

Curriculum Guide
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Lesson Skills

Approximate  
Completion Time 

(in hours)

4.5 MLB All-Time 
Leaders

Working with Data in a 
Table

 Sort table data  Change text direction in a 
table

.75

4.6 Let’s Make a Date Using Quick Tables  Use Quick Tables  Use AutoFit to resize tables .75

4.7 Career and  
Technical  
Education

Modifying a Table  Configure a repeating row header  Split 
tables

.75

4.8 Shopping List Performing Calculations in 
a Table

 Calculate the sum of a column or row  Find 
the average of a column or row  Determine 
the product of a row  Format the results of a 
formula  Toggle field codes  Update a formula

.75

4.9 School Fundraiser Working with Excel in Your 
Document

 Insert a table as an Excel spreadsheet  Use 
SUM, AVERAGE, MIN, and MAX functions  Change 
number format in a spreadsheet  Use Fill options

.75

4.10 Career  
Exploration

Inserting Objects  Insert text from a file or external source .75

Part 4 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Part 5:  Working with Tabs

5.1 Guidance  
Counselor  
Caseloads

Using Tab Basics  View the Ruler  Use the default tab .5

5.2 Hot Jobs Converting Text to Tables  Set tabs using the ruler  Convert text to 
tables

.75

5.3 Kid Millionaires Setting Custom Tabs  Set tabs using the dialog box  Use dot leaders .5

5.4 Shopping List 2 Converting Tables to Text  Convert tables to text .5

5.5 Honors Night 
Program

Changing Tab Alignment  Clear tabs .5

Part 5 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Part 6:  Working with Columns and Page Setup

6.1 ID Theft Formatting Text into 
Columns

 Format text in multiple columns  Set up 
document pages

.75

6.2 Password Power Using Column Breaks  Set up document pages  Insert column breaks .75

6.3 Top Performers Enhancing the Appearance 
of the Page

 Set up document pages  Configure page 
background elements  Insert section breaks  
 Change page setup options for a section

.75

6.4 ID Theft 2 Adding a Cover Page to a 
Document

 Insert a cover page  Configure page 
background elements

.75

6.5 Password Power 2 Enhancing Document 
Columns

 Apply hyphenation  Adjust column width .5

Part 6 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.
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Lesson Skills

Approximate  
Completion Time 

(in hours)

Part 7:  Using Headers, Footers & References

7.1 Student Council 
Letterhead

Using Headers and Footers  Insert and modify headers and footers .75

7.2 Classroom Rules Formatting Headers and 
Footers

 Insert and modify headers and footers  Insert 
page breaks  Insert a signature line

.75 - 1

7.3 ID Theft 3 Advanced Headers and 
Footers

 Insert and modify headers and footers  
 Change page setup options for a section

.5 - .75

7.4 Job Descriptions Working with Bookmarks  Link to locations within documents  Move to 
specific locations and objects in documents

.75

7.5 Protect Yourself Working with a Table of 
Contents

 Insert tables of contents  Update a table of 
contents

.75 - 1

7.6 Protect Yourself 2 Working with Citations  Create and modify bibliography citation 
sources  Insert citations for bibliographies 
 Insert bibliographies  Customize tables of 
contents

.75 - 1

7.7 Risks and Rewards 
of Social Media

Working with a Table of 
Figures

 Insert figure and table captions  Modify 
caption properties  Modify styles  Insert and 
update a table of figures

.75

7.8 Waiver and  
Release Form

Working with Footnotes 
and Endnotes

 Insert footnotes and endnotes  Modify 
footnote and endnote properties

.75 - 1

7.9 Needs vs. Wants Navigating a Document 
Efficiently

 Split the window  Search for text  Move to 
specific locations or objects in documents

.75 - 1

Part 7 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Part 8:  Working with Graphics and Visual Elements

8.1 High School Musical 
Auditions Flyer

Inserting and Working with 
Pictures

 Insert pictures  Wrap text around objects  
 Format graphic elements  Position objects 

.75

8.2 Letterhead with 
Picture

Formatting Picture Styles  Apply picture styles  Format graphic 
elements

.5

8.3 Start Saving Combining Pictures with Text  Wrap text around objects  Position objects  
 Apply document themes

.75

8.4 Life Cycle of a 
Butterfly

Using Shapes  Insert SmartArt graphics  Add and modify 
SmartArt graphic content  Format SmartArt 
graphics  Insert shapes  Add and modify text 
in shapes  Format graphic elements  Align 
objects  Group objects

1

8.5 Visual Resume Working with Graphic 
Elements

 Use WordArt  Insert text boxes  Use 
alignment guides  Distribute objects  Format 
graphic elements

1

8.6 YouTube  
Superstars

Inserting an Online Video  Insert an online video  Crop a picture  
 Format graphic elements

.75
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Lesson Skills

Approximate  
Completion Time 

(in hours)

8.7 YouTube Stats and 
Facts

Inserting a Screenshot  Insert screenshots and screen clippings .75

8.8 Slater Farms Enhancing Pictures  Insert pictures  Apply artistic effects  Apply 
picture effects  Remove picture backgrounds

.75

8.9 Slater Farms 2 Working with Accessibility 
and Compatibility Issues

 Change text to WordArt  Locate and correct 
accessibility issues  Add alternative text to 
objects  Locate and correct compatibility issues

.75

8.10 Your New Best 
Friend

Inspecting Documents for 
Issues

 Show and hide formatting symbols and 
hidden text  Locate and remove hidden 
properties and personal information  Locate 
and correct compatibility issues

.75

8.11 Home Office 
Design

Working with 3D Models  Insert 3D models  Format 3D models  
 Format graphic elements

.75

8.12 Customer Loyalty 
Card

Formatting SmartArt 
Graphics

 Add and modify text in text boxes  Add 
and modify text in shapes  Add and modify 
SmartArt graphic content  Format graphic 
elements

.75

8.13 Thank You Card Using Digital Ink  Set up document pages  Draw using digital 
ink  Use Ink to Shape

.75

8.14 Cupcake Wars Using Templates  Create a blank document using a template .5

Part 8 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Part 9:  Sharing and Working Collaboratively

9.1 The Importance of 
Unplugging

Managing Track Changes  Track changes  Review tracked changes  
 Accept and reject tracked changes  Lock and 
unlock change tracking

.75

9.2 Finding a Career Using Comments to 
Communicate Changes

 Add comments  Review and reply to 
comments  Resolve comments  Delete 
comments

.75

9.3 Step By Step Sharing Files  Save a document to OneDrive  Share 
documents electronically  Assign collaboration 
permission  Move OneDrive files

.75

9.4 Feedback 101 Managing Revisions  Create a new document with Word Online 
 Edit documents with Word Online  Review 
version history

.5

9.5 Who Am I Using Comments While 
Collaborating

 Collaborate simultaneously  Add and 
manage comments in Word Online

.75

9.6 Top 10 Customers Working with AutoSave  Using AutoSave  Using Version History .75 - 1

Part 9 Skills Mastery Skills Mastery Quizzes are located with the Instructor Resources.

Total Completion Time: 50 - 53 hrs.
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Part 1
Document Basics

1.1	 Oh, the Places You’ll Save! 
Exploring Places to Save Work

1.2	 Getting Started
Navigating Word

1.3	 Start of the Year Goals
Creating Your First Document

1.4	 Start of the Year Goals 2
Retrieving a Document

1.5	 Believe Me Ideas
Emailing a Document

1.6	 How to Get There
Editing Basics

1.7	 What Kind of Learner Am I?
Customizing the Quick Access Toolbar

1.8	 You Are So Smart
Getting Help and Information

1.9	 My Action Plan
Working with PDF File Types

Part 1 Skills Mastery
Skills Mastery Quizzes are located with the Instructor Resources.
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File Manager: 
The interface you use to view your 
computer’s folder structure is called a 
file manager. Windows 10 utilizes File 
Explorer. When launched, it allows 

the user to see folders and files located on the computer’s 
hard drive, network drive, and any connected removable 
drives. Some cloud storage drives may also be visible if your 
computer has been configured to connect automatically to 
a cloud storage account.

Lesson 1.1 

Network Drive: 
Many organizations such as schools 
and companies give users access to 
a shared computer drive called a 
network drive. This large hard drive 

contains files from all users in the organization and would 
require a login provided by the network manager. Saving 
work to a network drive allows you to retrieve that work 
once you have logged in to the network.

Local Drive: 
A computer’s local drive is the hard 
drive located inside your computer. 
It is the place that programs are 
typically installed and where files 

can be saved. If files are saved to a computer’s local drive, 
they can only be opened from that particular computer.

Removable Drive: 
There are many types of removable 
storage devices which a computer 
can accept. Examples include 
external hard drives, USB drives 

(also referred to as thumb drives or flash drives), and 
memory cards. Often these drives are used to back up files, 
but they are also used to transport your work from one 
computer to another.

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Part 1: Document Basics 

Oh, the Places You’ll  
Save! 
Exploring Places to Save Work

Lesson Overview
When using a computer, saving an electronic document is much like saving hard copies of documents—they 
need to be put somewhere. Imagine your computer is a file cabinet with many drawers. In each drawer there 
are folders and in each folder there are subfolders and files. Just as you would never just toss a document into a 
random drawer, you would never save work without first deciding on which drawer, or in this case which drive, to 
save it. Once the drive has been chosen, you can be even more specific about your organization and save the file 
to a particular folder within that drive.

In this lesson, you will identify and explore the places that work can be saved. You will not be required to save any work. 

Skills
�� Use File Manager

�� Create a folder

�� Log in to OneDrive

�� Sync to OneDrive 
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Tools & Terms (cont.)

Office 365: 
A subscription to Office 
365 provides users with 

periodic updates to Microsoft Office’s desktop and online 
applications. While users of Word 2019 will be able to 
create, format, save, and share documents, using Office 
365 means that Word will be automatically updated with 
any updates that Microsoft makes available. Office 365 
subscribers also have an added feature allowing them to 
AutoSave documents to the user’s OneDrive account. 

Since Office 365 is regularly updated, what appears on your 
screen may differ from the instructions and screenshots 
presented in this text. However, with minor modifications, 
most lessons can be completed successfully.

AutoSave: 
Many online applications, 
such as Word Online, provide 
automatic saving of your 

files to your cloud storage. As you work, the application 
will periodically save your changes without you having 
to initiate the save. Office 365 subscribers can take 
advantage of AutoSave to have documents that are saved 
to OneDrive automatically updated as they work. Since files 
are overwritten periodically, you may want to preserve an 
original copy of a file before making changes. Utilize Save a 
Copy before making changes to a document or use Version 
History to bring back previous versions of the file. 

Lesson 1.1Exploring Places to Save Work

Cloud Drive: 
Cloud storage allows a user to 
work with files that are physically 
unattached to your computer. 
Files are saved to a place that 
is accessed via the web, which 
makes working from various 

places easy and convenient. As long as you have an 
Internet connection, you have access to your cloud drive. 
Examples of cloud storage include OneDrive, Google Drive, 
and Dropbox. Many cloud storage platforms provide an 
application to work on the file. For example, when opening 
a Word document from OneDrive, the user has the option 
to edit the document directly in their web browser without 
having to open their Microsoft Word 2019 program. 

Important Note: In this lesson, you will set up folders on your hard drive or network drive and your OneDrive. This 
process will vary depending on your workstation settings.

1.	 Create a folder on your hard drive or network drive and name it My Word Projects.

2.	 Unless you are already set up to connect with your OneDrive account automatically, log in to your OneDrive 
account from OneDrive.com.

3.	 Create a new folder on your OneDrive and name it My Online Word Projects.

4.	 Sync your OneDrive account to your computer.

 Note: You will be instructed in each lesson on what to name the lesson file and on which drive to save it.

Instructions

Syncing: 
It is possible to sync your OneDrive 
account to your computer. Syncing 
provides access to the folders and 
files on your OneDrive cloud storage 
account when you are working offline. 
It also allows your OneDrive cloud 
storage folders to appear in your 

computer’s file management interface. Otherwise, you must 
open OneDrive.com from your computer’s web browser to 
upload and download saved documents.
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Lesson 1.2 

Launching Word & Working with Files

Lesson Overview
Microsoft Word 2019 is a powerful word processing tool used by millions 
of people worldwide. Developing skills in this application will make you 
more productive and efficient when completing schoolwork and projects. 
Word allows a user to create, edit, print, and share many different types of 
documents. These documents can include text, graphics, hyperlinks, and 
video elements to make your work an effective form of communication 
with various audiences. 

In this lesson, you will become familiar with the Word application interface. 
You will not be required to save any work. 

Part 1: Document Basics 

Getting Started
Navigating Word

Skills
�� Create a blank 
document 

�� Understand Backstage 
View

�� Identify tabs and groups

�� Change document 
views

�� Customize views by 
using zoom settings

�� Close Word

Start Screen
When Microsoft Word opens, the first thing you see is the 
Start Screen. From the Start Screen you can open existing 
documents from a list of recent, pinned, or shared files, or 
create a new file using a blank document or new document 
template. You also can look for more templates online using 
the Start Screen search tool. 

Backstage View
Located by clicking the File tab, the Backstage View is the 
central place for managing your documents. Actions such as 
saving, printing, sharing, exporting, or opening previously saved 
files can also be done here. Different options appear depending 
on your selection. For example, when you select Open, your 
computer’s file folders and cloud folders appear on screen. 

Clicking on the back arrow, or the Esc Key, 
returns you to the open file.

The Word program icon launches Microsoft Word 2019 from the Windows Start Menu or Start Screen. 
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Lesson 1.2Navigating Word

Application Window
The Word application window displays the working area of your document and 
provides access to the tools needed to enter, edit, and format text and other content.

Ribbon Parts
The Word ribbon user interface keeps related tools organized and easily accessible.

Tools are organized within tabs, which contain groups of related features and commands. 
Graphical icons or menu items control the editing and formatting of a Word document. 
Some tools or groups have additional options accessible from a drop-down menu or 
dialog box launcher.

Application Window Key 

A 	 AutoSave
	 Allows Office 365 users to 

automatically save their document 
to OneDrive or SharePoint every 
few seconds

B 	 Quick Access Toolbar
	 Commonly used commands at the 

top of the application window, which 
can be customized to stay visible

C 	 Ribbon
	 Groups of related tools organized 

within a set of tabs, which can be 
collapsed or expanded

D 	 Program Window Controls
	 Allow you to move, resize, and 

close the application window, and 
customize ribbon display options

E 	 Share Control
	 Allows you to share a document 

with another user and see who a 
document is currently shared with

F 	 Comments
	 Allows you to review and respond to 

comments in a document

G 	 Page
	 The area on which your content 

appears as it is entered and 
formatted

H 	 View Controls
	 Adjust zooming in and out of 

a document, as well as select 
document view options

Ribbon Parts Key 

A 	 Tab
	 Displays the ribbon’s name and 

contains related groups of different 
tools and commands to perform 
the most common tasks

B 	 Group
	 Contains related features and tools 

organized within a ribbon’s tab

C 	 Drop-down Menu
	 Allows you to select a command 

from a list of options

D 	 Icon
	 An interactive tool that activates its 

feature when clicked

E 	 Dialog Box Launcher
	 Opens a window with information 

and options about a particular tool 
or group
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Lesson 1.2 Navigating Word

Page Key

A 	 Indent Marker
	 Allows you to indent paragraphs to 

a desired location

B 	 Horizontal Ruler
	 Helps determine the position of 

content and margins going left to 
right on a page

C 	 Page Margins
	 Blank space that is set around the 

edges of the page

D 	 Insertion Point
	 Indicates the position on the page 

where text and content is placed

E 	 Page
	 The space where text and content 

is entered and positioned for on-
screen reading or printing

F 	 Vertical Ruler
	 Helps determine the position of 

content and margins going top to 
bottom on a page

View Controls Key

A 	 Document View Options
	 Allow you to select document view 

options that include Read Mode, 
Print Layout (default), and Web 
Layout. These options, along with 
Outline and Draft View, can also be 
found in the View tab, Views group.

B 	 Zoom Adjustment
	 Adjusts zooming in and out of a 

document

Status Bar Key

A 	 Page Number 
	 Displays current page number and 

opens the Navigation pane to allow 
the user to navigate to a specific 
page in the document

B 	 Word Count 
	 Opens a dialog box that displays the 

current word and character count 
of the file

C 	 Editor 
	 Provides corrections to spelling, 

grammar, and stylistic issues

Page
The Word page is where text and other content is entered, edited, and 
formatted. Pages have margins within which content is aligned. 

View Controls
The controls at the bottom right of the document adjust zoom and present 
different page view options.

B

C Editor

A Page Number

Word Count

Status Bar
The Status Bar can be easily customized to give you information about the 
document you are working on by right clicking on the bar.
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10.

3.

9.

Insertion Point

11.

Lesson 1.2Navigating Word

Instructions
1.	 Locate the Word program icon and launch Word 2019.  

2.	 From the Start screen, Home section, select Blank document.

3.	 At the top of the document where the insertion point (cursor) is flashing, key 
your last name.

4.	 Hit the Enter key and notice how your cursor moves to the next line.

5.	 Key the text [It is fun getting to know how to use Microsoft Word 2019].

6.	 Go to the Backstage View of Word by clicking on the File tab. Notice the saving 
and printing options available.

7.	 Click on the Arrow (or hit the Esc key) to return to your open document.

8.	 Practice getting to know the Ribbons and their parts by clicking some of the 
Tabs such as Insert, Design, Layout, View, etc. (as shown below):

9.	 While exploring the various tabs, notice the groups of related features and 
commands, such as the Font and Paragraph groups within the Home tab.

10.	 Within some of the groups, notice the diagonal arrow in the bottom right 
corner. This is the Dialog Box Launcher for that group. Click on one to see the 
dialog box it opens. 

11.	 Click on a few of the Drop-down Menus and notice the different tool options. 

12.	 Become familiar with the different document view options by clicking on the 
icons within the View tab, Views group (as shown below):

13.	 Close Word by clicking on the X icon in the top right corner of the  
window. 

 Note: Do not save your document.

7Part 1: Document Basics For Evaluation Purposes Only



Text Highlight Color:  
Use the drop-down menu to make your 
text pop by highlighting it in a bright color.

Text Effects and Typography:  
Use the drop-down menu to add some 
flair to your text by applying a text effect, 
such as a shadow or a glow.

Format Painter:  
Use this icon to apply similar formatting from 
one particular selection to another.

Lesson 2.3

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Skills
�� Apply text effects

�� Apply a text highlight 
color

�� Apply formatting by 
using Format Painter

Part 2: Formatting Text 

Back to School BBQ
Formatting Text with Effects

Lesson Overview
When choosing font styles and text format, it is important to consider the 
tone your typeset conveys. For instance, if your work is considered a light 
and fun topic, choose a font such as Comic Sans or Harrington to show 
the reader that you are not being too serious. Good visual communication 
design also takes into account consistent styles for similar items. A good 
example of this is when a document contains the same text style for 
all headings on a page. Once you have chosen a desired style for your 
headings, the Format Painter function can help you to easily apply the same 
format to other text. Uniformity in the look of your document can help with 
the overall neatness of the page.

In this lesson, you will create an invitation for the annual back to school picnic. 
The invitation will be enhanced with text effects and font styles to make it easier 
for students to read.
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1.	 Using Word 2019, create a new Blank document.

2.	 Save the file as 2.3 Back to School BBQ in your My Word Projects folder on 
your hard drive or network drive.

3.	 At the top of the document, key the text as shown in Figure 2.3 A.

4.	 From the Home tab, Font group, do the following: 

a.	 Select the entire document and change the font to Footlight MT Light.

b.	 Change the font size of the title [Back to School BBQ] to 26,  
and apply a Text Effect of Blue outline.

c.	 Apply the Text Highlight Color of Yellow to the subtitle [Food choices will 
include:].

5.	 From the Home tab, Clipboard group, do the following:

a.	 Using the Format Painter tool, apply the same format  
that was used on the text [Food choices will include] 
to the text [The night will feature:].

6.	 Proofread your document for accuracy and format, then resave the file.

7.	 Print preview. Your document should look similar to Figure 2.3 B.

8.	 Print or share the document if required by your instructor.

5. 4.

4b.

4c.

Formatting Text with Effects Lesson 2.3

Instructions
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Back to School BBQ 

Join us for a back to school picnic! Everyone is welcome, including family members, to come and enjoy 
the good food and games. Reconnect with friends you have not seen all summer! Meet someone new! 

Food choices will include: 

Hamburgers 

Hot dogs 

Pulled pork 

Pizza 

Corn on the cob 

Watermelon 

The night will feature: 

Obstacle courses 

Games for all ages 

Raffles 

Live music 

Pie eating contest 

Festivities start at 6 pm and end with a fantastic fireworks display in the back field. Bring a blanket or a 
chair. 

Figure 2.3 A

Lesson 2.3 Formatting Text with Effects
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Join us for a back to school picnic! Everyone is welcome, including family members, to come and enjoy 
the good food and games. Reconnect with friends you have not seen all summer! Meet someone new! 

Food choices will include: 

Hamburgers 

Hot dogs 

Pulled pork 

Pizza 

Corn on the cob 

Watermelon 

The night will feature: 

Obstacle courses 

Games for all ages 

Raffles 

Live music 

Pie eating contest 

Festivities start at 6 pm and end with a fantastic fireworks display in the back field. Bring a blanket or a 
chair. 

Figure 2.3 B

Lesson 2.3Formatting Text with Effects
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Bullets and Numbering: 
Use these icons to create standard bulleted and 
numbered lists. 

Using the drop-down menus allows for 
selection of different bullet or number options, 
or defining new bullet characters or number 
formats.

Multilevel List: 
Use this icon to create a multilevel list to 
organize items like you would see in an 
outline. 

Using the drop-down menu allows for 
selection of different numbering options 
from the List Library such as increasing or 
decreasing a list level.

Set Numbering Value: 
Use this dialog box to 
redefine the value of a 
numbered item. You can 
restart numbering or 
continue from a previous 
list item, or input a new 
value for the list item. 
Subsequent numbers 
in the list will adjust 
to maintain a correct 
sequence.

Lesson 3.4

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Part 3: Formatting Paragraphs & Editing Text 

I’m So Bored!
Creating Lists

Lesson Overview
One way to present information in an organized way is by creating a list. 
Microsoft Word 2019 can recognize the creation of a bulleted or numbered 
list when you begin to type one, and will automatically continue the 
sequence each time you start a new line. Text that has already been typed 
can also be formatted as a list with standard or custom bullets as well as with 
numeric or alphabetic sequential numbers. 

In this lesson, you will create a list of fun activities to do when you and your 
friends are bored. The document will contain a bulleted list of group activities.  
A multilevel list will break down three group event activities and detail them in  
an outline style.

Skills
�� Format paragraphs as 
numbered or bulleted 
lists

�� Increase and decrease 
list levels

�� Set starting number 
values

�� Restart list numbering 

�� Change bullet 
characters and number 
formats

�� Define custom bullet 
characters 
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1.	 Using Word 2019, create a new Blank document.

2.	 Change the line spacing to single, with no additional space before or after 
paragraphs. 

 Hint: You can select the Single spaced (blank) document option from the 
Start screen.

3.	 Save the file as 3.4 I’m So Bored in your My Word Projects folder on your hard 
drive or network drive.

4.	 At the top of the document, key the text as shown in Figure 3.4 A. 

 Note: Leave one blank line after the title and between the types of activities.

5.	 Make the following formatting changes:

a.	 Change the font of the entire document to Garamond.

b.	 Center and bold the title [Things to Do When I Am Bored], then change 
the font size to 20.

c.	 Bold the following activity titles: [Solo Activities], [Group Activities], and 
[Group Events].

6.	 From the Home tab, Paragraph group, do the following:

a.	 Select the list of [Solo Activities] and create a Bulleted List.

b.	 Select the list of [Group Activities] and create a Numbered List.

c.	 Select the list of [Group Events] and create a Multilevel List using the 
option under Current List.

7.	 From the Home tab, Paragraph group, Multilevel List drop-down menu,  
do the following:

a.	 Select the ten items below [Host a Make Your Own Pizza Party], select 
Change List Level and then select Level 2.

b.	 Select the 6 items below [Chop and prepare the toppings] and change to 
Level 3.

c.	 Change the list level of the four items below [Host a Campfire] to Level 2.

8.	 From the Home tab, Paragraph group, Numbering drop-down menu, do the 
following:

a.	 Select the first list item in [Group Events] and select Set Numbering Value....

b.	 In the Set Numbering Value dialog box, set value to 7 and click OK.

6c.

7a.

8a.

8b.

6.

Creating Lists Lesson 3.4

Instructions
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9.	 Select the four items below [Host a Campfire], right click, and select Restart at a.

10.	 Select the 6 items below [Chop and prepare the toppings], and select the black 
circle bullet from the Bullet Library from the Bullets drop-down menu.

11.	 Select [Write a book] in the bulleted list of [Solo Activities] and from the Home 
tab, Paragraph group, Bullets drop-down menu, do the following:

a.	 Select Define New Bullet....

b.	 From the Define New Bullet dialog box, click Symbol....

c.	 In the Symbol dialog box (shown below), change the font to Wingdings, in 
the Character code: field, key [38], then click OK.

d.	 In the Define New Bullet dialog box, click OK.

12.	 Proofread your document for accuracy and format, then resave the file.

13.	 Print preview. Your document should look similar to Figure 3.4 B.

14.	 Print or share the document if required by your instructor.

11.

9.

11a.

10.

11b.

11d.

Lesson 3.4 Creating Lists
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Things to Do When I Am Bored 
 
Solo Activities 
Volunteer 
Draw 
Write a book 
Cook 
Yoga 
Make a movie 
Rearrange your bedroom  
 
Group Activities 
Bowling 
Roller skating 
Ice skating 
Sports of any kind 
Snow tubing 
Movie 
 
Group Events 
School Sporting Event 
Host a Make Your Own Pizza Party 
Make invitations 
Decorate the space 
Prepare the dough 
Chop and prepare the toppings 
Sauce 
Cheese 
Pepperoni 
Mushrooms 
Olives 
Onions 
Host a Campfire 
Make invitations 
Arrange the space 
Prepare the fire 
Gather sticks for roasting marshmallows 
Music Concert 
 

Figure 3.4 A

Lesson 3.4Creating Lists
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Things to Do When I Am Bored 
 
Solo Activities 

 Volunteer 
 Draw 
 Write a book 
 Cook 
 Yoga 
 Make a movie 
 Rearrange your bedroom  

 
Group Activities 

1. Bowling 
2. Roller skating 
3. Ice skating 
4. Sports of any kind 
5. Snow tubing 
6. Movie 

 
Group Events 

7. School Sporting Event 
8. Host a Make Your Own Pizza Party 

a. Make invitations 
b. Decorate the space 
c. Prepare the dough 
d. Chop and prepare the toppings 

 Sauce 
 Cheese 
 Pepperoni 
 Mushrooms 
 Olives 
 Onions 

9. Host a Campfire 
a. Make invitations 
b. Arrange the space 
c. Prepare the fire 
d. Gather sticks for roasting marshmallows 

10. Music Concert 

Figure 3.4 B

Lesson 3.4 Creating Lists
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Translate Document: 
Use this icon to create a translated copy of the document 
by selecting the languages to translate from and to. 

Translate Selection: 
Use this icon to translate a selection of text by selecting 
the languages to translate from and to. The translated 
selection can then be inserted back into the document. 
The Translator can also provide information about each 
word, including alternative translations.

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Part 3: Formatting Paragraphs & Editing Text 

Travel Help
Translating Text

Lesson Overview
Technology has come a long way in the area of language translation. With 
the Translate feature of Microsoft Word 2019, converting digital text from 
one language to another has never been easier. When translating an entire 
document, Word will create a copy of the document in one of over 60 
different languages. You can also select specific lines of text to translate and 
insert into your document. Remember, though, that while translating text can 
make it easier for you to understand something written in another language, 
the translation may not be completely accurate.

In this lesson, you will translate a document of common travel phrases from 
Spanish to English. Then you will translate selected phrases into Italian and French. 

In order to complete this lesson, access to a lesson resource file is required 
and should be provided by your instructor.

Lesson 3.11

Skills
�� Translate a selection

�� Translate an entire 
document

�� Insert translation results 
into a document
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3a.

6b.

3b.

6c.

3c.

3d.

6d.

6e.

3.

Translating Text Lesson 3.11

Instructions
1.	 Launch Word 2019 and open the file named Lesson 3.11 SOURCE. 

2.	 Save the file as 3.11 Travel Help-Spanish in your My Word Projects folder on 
your hard drive or network drive.

3.	 From the Review tab, Language group, do the following:

a.	 From the Translate drop-down menu, select Translate Document.

b.	 In the Translator task pane, select Spanish from the From drop-down 
menu.

c.	 Select English from the To drop-down menu.

d.	 Click Translate.

4.	 Change [You speak english?] to [Do you speak English?].

 Note: As with any machine translation, Word’s Translate feature may 
produce grammatical or formatting errors.

5.	 Save the translated file as 3.11 Travel Help-English in your My Word Projects 
folder on your hard drive or network drive.

6.	 From the Review tab, Language group, do the following:

a.	 Select the text [Do you speak English?].

b.	 From the Translate drop-down menu, select Translate Selection.

c.	 In the Translator task pane, select English from the From drop-down 
menu.

d.	 Select Italian from the To drop-down menu.

e.	 Move your cursor to the right of the text [Italian -] below the text [Do you 
speak English?], add a space, then click Insert in the task pane.

f.	 Change the To language to French.

g.	 Move your cursor to the right of the text [French -] below the text [Do you 
speak English?], add a space, then click Insert in the task pane.

h.	 Close the Translator task pane.

7.	 Repeat step 6 for the remaining phrases.

 Hint: Remove any extra spaces added before the question marks.
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Lesson 3.11 Translating Text

8.	 Bold the English phrases in the document.

9.	 Add and remove blank lines as shown in Figure 3.11.

10.	 Proofread your document for accuracy and format, then resave the file.

11.	 Print Preview. Your document should look similar to Figure 3.11.

 Note: Some translations may vary.

12.	 Print or share the documents if required by your instructor.
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Do you speak English? 
Italian - Parli inglese? 
French - Parles-tu Anglais? 
 
Can you talk slower? 
Italian - Puoi parlare più lentamente? 
French - Tu peux parler plus lentement? 
 
Can you take me to the airport, please? 
Italian - Puoi portarmi all'aeroporto, per favore? 
French - Pouvez-vous m'emmener à l'aéroport, s'il vous plaît? 
 
How much does this cost? 
Italian - Quanto costa? 
French - Combien cela coûte-t-il? 
 
Do you take credit cards? 
Italian - Prendi le carte di credito? 
French - Prenez-vous des cartes de crédit? 
 
Where's the nearest bathroom? 
Italian - Dov'è il bagno più vicino? 
French - Où est la salle de bain la plus proche? 
 
Where can I get something to eat? 
Italian - Dove posso prendere qualcosa da mangiare? 
French - Où puis-je trouver quelque chose à manger? 
 
Can you show me on a map how to get there? 
Italian - Puoi mostrarmi su una mappa come arrivarci? 
French - Pouvez-vous me montrer sur une carte comment y arriver? 
 
Can you write that for me? 
Italian - Puoi scriverlo per me? 
French - Tu peux m'écrire ça? 
 
I'm lost. 
Italian - Mi sono perso. 
French - Je me suis perdu. 
 
I'm an American citizen. 
Italian - Sono un cittadino americano. 
French - Je suis un citoyen américain. 

Figure 3.11

Lesson 3.11Translating Text
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Shading: 
Use the drop-down menu to change 
the color behind the selected text, 
paragraph, or table cell. 

Resize Table: 
Use the resizing handle to change the size of 
the table. 

Borders: 
Use the drop-down menu to add or 
remove borders from your selection. 

Cell Margins: 
Use this icon to customize the margins 
within a cell and the space between 
cells. 

Lesson 4.3

Skills
�� Shade cells, rows, and 
columns

�� Apply borders

�� Configure cell margins 
and spacing

�� Resize tables

Part 4: Working with Tables 

City Life
Formatting Tables

Lesson Overview
Tables help your audience understand the content of a document by 
organizing information into rows and columns. Adding shading or an 
attractive border to the table can enhance the overall appearance of the 
document. Borders are shown by default in Microsoft Word 2019, but you 
can customize their appearance for the entire table or a particular side 
of a cell. Column headings and rows can be shaded to help the reader 
understand the table. In addition, the contents of a cell can become 
more legible with the addition of cell margins and spacing. Cell margins 
and spacing can be adjusted after text has been entered, giving you the 
opportunity to see just how much room you would like around the content 
within the cell as well as how much space falls between cells.

In this lesson, you will learn how to shade and add  borders, as well as change 
cell margins to add to the professional look of the table.

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.
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1.	 Using Word 2019, create a new Blank document.

2.	 Save the file as 4.3 City Life in your My Word Projects folder on your hard drive 
or network drive.

3.	 At the top of the document, create a table with 4 columns and 12 rows, and 
key the text as shown in Figure 4.3 A. 

4.	 From the Table Tools, Table Design tab, Table Styles group, do the following:

a.	 Select row 2 and from the Shading drop-down menu, select Green, 
Accent 6, Lighter 40%.

5.	 Select the entire table and from the Table Tools, Table Design tab, Borders 
group, do the following:

a.	 From the Line Style drop-down menu, select a Triple Line Line Style. 

b.	 From the Borders drop-down menu, select All Borders.

6.	 Select the entire table and change all of the column widths to 1.5”, then center 
it horizontally on the page.

7.	 Select row 1 and do the following:

a.	 Merge the cells and center the text.

b.	 Bold the text and change the font size to 18.

8.	 Select the entire table and from the Table Tools, Layout tab, Alignment group 
(shown below), do the following:

a.	 Click Cell Margins.

b.	 From the Table Options dialog box, change the left margin to .2”.

c.	 Check Allow spacing between cells and enter .04”, then click OK.

d.	 Drag the resizing handle in the bottom right corner of the 
table to the left to resize the table to its smallest width.

9.	 Proofread your document for accuracy and format, then resave the file.

10.	 Print preview. Your document should look similar to Figure 4.3 B.

11.	 Print or share the document if required by your instructor.

5a.

4a.

5b.

8b.

8c.

4. 5.

Formatting Tables Lesson 4.3

Instructions
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    W‐3 Source Doc. 

Welcome to Jackson High School! I am excited to welcome you back to school today. The office has been 
working full‐time over the summer to ensure a smooth opening for you. During your extended 
homeroom period today, you will be reviewing your schedules, locker and lunch information. We will 
have an abbreviated schedule today so you can meet all of your new teachers. If you have any other 
questions, please feel free to ask any staff member or stop by the main office today. We all hope you 
have a great first day. 

 

Martha, do not indent yet, students don't know tab key.  

America’s Biggest Cities    
Rank City State Population 
1 New York NY 8,336,697 
2 Los Angeles CA 3,857,799 
3 Chicago IL 2,714,856 
4 Houston TX 2,160,821 
5 Philadelphia PA 1,547,607 
6 Phoenix AZ 1,488,750 
7 San Antonio TX 1,382,951 
8 San Diego CA 1,338,348 
9 Dallas TX 1,241,162 
10 San Jose CA 982,765 

 

 

 

America’s Biggest Cities 
Rank City State Population 

1 New York NY 8,336,697 

2 Los Angeles CA 3,857,799 

3 Chicago IL 2,714,856 

4 Houston TX 2,160,821 

5 Philadelphia PA 1,547,607 

6 Phoenix AZ 1,488,750 

7 San Antonio TX 1,382,951 

8 San Diego CA 1,338,348 

9 Dallas TX 1,241,162 

10 San Jose CA 982,765 

 

 

 

Figure 4.3 A

Figure 4.3 B

Lesson 4.3 Formatting Tables
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Table Styles: 
Use these icons to quickly apply or change the visual style of your table.

Lesson 4.4

Tools & Terms
Review the following tool that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of this tool by completing the Skills Mastery Quizzes for this part.

Skills
�� Apply table styles

�� Modify table styles

Part 4: Working with Tables 

City Life 2
Enhancing Tables with Styles

Lesson Overview
Although customizing a table with borders, shading, alignment, and fonts 
is quite simple, it is just as easy to take advantage of the built-in table styles 
Microsoft Word 2019 has to offer. The Table Styles gallery contains table 
designs with unique formatting elements. Applying a style from the gallery 
allows you to perform multiple format changes at once. Hovering your mouse 
over a style transforms your table with the defined formats for a quick preview 
before you actually select it. If you like most, but not all, of the elements of 
one style, you can make minor changes to it and save it for future use.

In this lesson, you will apply a table style to an existing table and make a minor 
change to it.
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1.	 Launch Word 2019 and open the file named 4.3 City Life from your My Word 
Projects folder on your hard drive or network drive.

2.	 Save the file as 4.4 City Life 2 in your My Word Projects folder on your hard 
drive or network drive.

3.	 From the Table Tools, Table Design tab, Table Styles group, More drop-down 
menu, do the following:

a.	 Apply the Grid Table 4 – Accent 3 table style.

 Hint: Hovering your mouse over each style will show you its style name.

4.	 From the Table Tools, Table Design tab, Table Styles group, More drop-down 
menu, select Modify Table Style... and do the following (as shown below):

a.	 Change the font of the Whole table to Cambria.

b.	 Change the Line Style to Single Line and the Border Color to Gray, Accent 
3, Lighter 40%.

c.	 Click OK to apply the changes.

5.	 Center the table on the page.

6.	 Proofread your document for accuracy and format, then resave the file.

7.	 Print preview. Your document should look similar to Figure 4.4. 

8.	 Print or share the document if required by your instructor.

4a.

4b.

4c.

3.

3a.

4.

Enhancing Tables with StylesLesson 4.4

Instructions
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America’s Biggest 
Cities 

Rank City State Population 
1 New York NY 8,336,697 
2 Los Angeles CA 3,857,799 
3 Chicago IL 2,714,856 
4 Houston TX 2,160,821 
5 Philadelphia PA 1,547,607 
6 Phoenix AZ 1,488,750 
7 San Antonio TX 1,382,951 
8 San Diego CA 1,338,348 
9 Dallas TX 1,241,162 
10 San Jose CA 982,765 

 

 

 

Figure 4.4

Lesson 4.4Enhancing Tables with Styles
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Vertical Alignment: 
Use the Page Setup dialog box to change the vertical 
alignment of the text on your page. Centering text 
vertically (between the top and bottom margins) is most 
commonly used to create a cover page for a document. 
Alignment can be applied to the whole document or a 
section of it.

Page Border: 
Use the Borders and Shading dialog box to add or change 
the border around the page to add a stylish element to the 
document. 

Section Breaks: 
Use this drop-down menu to 
add a section break at your 
current location and start a 
new section of your document 
on the same page, next page, 
or the next even- or odd-
numbered page. 

Lesson 6.3

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Skills
�� Set up document pages

�� Configure page 
background elements

�� Insert section breaks

�� Change page setup 
options for a section

Part 6: Working with Columns and Page Setup 

Top Performers
Enhancing the Appearance of the Page

Lesson Overview
Page setup is most commonly used to set margins, page size, and layout 
orientation. However, a document’s appearance can improve if it is centered 
vertically and a page border is added. When a page is centered vertically, 
Microsoft Word 2019 will precisely center all paragraphs, tables, and objects 
without the need to insert blank lines before paragraphs or increase the top 
margin. You can also finish the document with a page border, which can be 
simple solid lines with various weights, or have a more creative design.

In this lesson, you will create a table listing popular musicians, center it vertically 
on the page, and then add a page border to enhance its appearance.
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5a.

5.

Enhancing the Appearance of the Page Lesson 6.3

Instructions
1.	 Using Word 2019, create a new Blank document.

2.	 Save the file as 6.3 Top Performers in your My Word Projects folder on your 
hard drive or network drive.

3.	 At the top of the document, insert a table with 3 columns and 11 rows, and key 
the text as shown in Figure 6.3 A. 

4.	 Center the table horizontally on the page.

5.	 From the Layout tab, Page Setup group dialog box, Layout tab, do the 
following: 

a.	 Change the Page, Vertical alignment to Center, then click Borders....

b.	 In the Borders and Shading dialog box, Page Border tab, click Box, then 
select Triple Line Style, select ¾ pt Width, then click OK to accept the 
changes (as shown below):

6.	 Make the following formatting changes:

a.	 In row 1, shade the cells Light Green and bold the text.

b.	 Align Center the text in the table.

c.	 Change the width of column 1 to .75”.

d.	 Change the height of all rows to .3”.

e.	 Change the font of the entire table to Georgia and the font size to 16.
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7.

7a.

9a.

9b.

9.

Lesson 6.3 Enhancing the Appearance of the Page

7.	 From the Layout tab, Page Setup group, do the following:

a.	 From the Breaks drop-down menu, select Next Page.

 Hint: Click to place your cursor under the table first.

8.	 Copy and paste the existing table onto the new page.

9.	 While still on page 2, from the Layout tab, Page Setup group dialog box, do the 
following:

a.	 Click the Margins tab, then change the Orientation to Landscape. 

b.	 Click the Layout tab, then click Borders....

c.	 In the Borders and Shading dialog box, Page Border tab, click Box, then 
select Double Wavy Line Style, select ¾ pt Width, Apply to This Section, 
then click OK to accept the changes (as shown below):

10.	 On page 2, make the following changes to the table:

a.	 Delete columns 1 and 3.

b.	 Insert three additional columns to the right of the table and key the text 
as shown in Figure 6.3 B.

 Hint: Change the first letter of each cell to lower case.

11.	 Proofread your document for accuracy and format, then resave the file.

12.	 Print preview. Your document should look similar to Figure 6.3 B.

13.	 Print or share the document if required by your instructor.
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Rank Celebrity Earnings 
1 Katy Perry $135 million 
2 One Direction $130 million 
3 Garth Brooks $90 million 
4 Taylor Swift $80 million 
5 The Eagles $73.5 million 
6 Calvin Harris $66 million 
7 Justin Timberlake $63.5 million 
8 Sean Combs $60 million 
9 Fleetwood Mac $59.5 million 
10 Lady Gaga $59 million 

 

Figure 6.3 A

Lesson 6.3Enhancing the Appearance of the Page
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Rank Celebrity Earnings
1 Katy Perry $135 million
2 One Direction $130 million
3 Garth Brooks $90 million
4 Taylor Swift $80 million
5 The Eagles $73.5 million
6 Calvin Harris $66 million
7 Justin Timberlake $63.5 million
8 Sean Combs $60 million
9 Fleetwood Mac $59.5 million
10 Lady Gaga $59 million

Celebrity Genre Debut Album Website
Katy Perry Pop One of the Boys katyperry.com

One Direction Pop Up All Night onedirectionmusic.com
Garth Brooks Country Garth Brooks garthbrooks.com
Taylor Swift Pop Taylor Swift taylorswift.com
The Eagles Rock Eagles eagles.com

Calvin Harris Electronic I Created Disco calvinharris.com
Justin Timberlake Pop Justified justintimberlake.com

Sean Combs Hip Hop No Way Out puffdaddyandthefamily.com
Fleetwood Mac Rock Fleetwood Mac fleetwoodmac.com

Lady Gaga Pop The Fame ladygaga.com
 

Figure 6.3 B

Lesson 6.3 Enhancing the Appearance of the Page
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Update Table: 
Use this icon to refresh the table of contents so that all 
entries reference the correct page number.

Table of Contents: 
Use this drop-down menu to provide an overview 
of your document with a table of contents.

Lesson 7.5

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Skills
�� Insert tables of contents

�� Update a table of 
contents

Part 7: Using Headers, Footers & References 

Protect Yourself
Working with a Table of Contents

Lesson Overview
A table of contents is a list of document headings along with their page 
numbers typically found at the start of a document. Microsoft Word 2019 
can provide a table of contents with hyperlinks to sections of text with just a 
few commands, making it easy to apply navigation to a file. Once the table 
of contents is complete, the user can simply click the hyperlinked table of 
contents entry and be brought directly to that section of the document.

In this lesson, you will combine text from two previous activities into a new 
document and create an automatic table of contents.
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1.	 Using Word 2019, create a new Blank document.

2.	 Save the file as 7.5 Protect Yourself in your My Word Projects folder on your 
hard drive or network drive.

3.	 Copy and paste (without formatting) only the body text of the following files: 
6.5 Password Power 2 and 7.3 ID Theft 3.

 Note: Do not copy cover pages, titles, or subtitles.

4.	 Delete the column break before [Eight Tips] and the page break before the last 
two paragraphs.

 Note: Your file should look similar to Figure 7.5 A, Pages 1 and 2.

5.	 Make the following formatting changes:

a.	 Key the text [Password Power] above the first paragraph and apply 
Heading 1 Style to the text.

b.	 Select the text [Eight Tips] and apply Heading 2 Style.

c.	 Select the text [Tip #1], [Tip #2], [Tip #3], [Tip #4], [Tip #5], [Tip #6],  
[Tip #7], and [Tip #8], and apply Heading 3 Style.

d.	 Key the text [Identity Theft] above the tenth paragraph and apply Heading 1 
Style to the text.

e.	 Key the text [Phone Calls] above the eleventh paragraph and apply 
Heading 2 Style to the text.

f.	 Key the text [Phishing] above the twelfth paragraph and apply Heading 2 
Style to the text. 

g.	 Justify all of the body text. 

6.	 Place your cursor at the top of the document and from the References tab, 
Table of Contents group, do the following:

a.	 From the Table of Contents drop-down menu, select Automatic Table 2 
from the Built-In section.

7.	 Key the text [Public Computers] above the thirteenth paragraph and apply 
Heading 2 Style to the text. 

8.	 From the References tab, Table of Contents group, click the Update Table icon, 
select Update entire table, then click OK.

9.	 Proofread your document for accuracy and format, then resave the file.

10.	 Print preview. Your document should look similar to Figure 7.5 B, Pages 1 and 2.

11.	 Print or share the document if required by your instructor.

6.

6a.

8.

Working with a Table of ContentsLesson 7.5

Instructions
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Passwords are like locks that keep our private information safe. Email, social networks, and some 
gaming websites all use passwords to help protect our private data. Without a strong password, private 
information can be easy for thieves to steal. There are websites to help you generate strong passwords, 
such as strongpasswordgenerator.com. You should also follow some tips for creating stronger 
passwords. 

Eight Tips 

Tip #1 - Do not use any self-identifying facts. Never use your full name, birth date, or address. 

Tip #2 - Avoid using obvious facts about yourself. Never use information that would be easy to guess, 
such as your nickname or your pet’s name.  

Tip #3 - Make passwords of at least eight characters. However, follow the instructions on a website for 
password length. Some websites may require passwords longer than eight characters. 

Tip #4 - Include a combination of numbers, symbols, and letters. This will make your passwords as 
unique as possible. Some websites require this combination of characters. Websites may also tell you 
whether a password is weak or strong. If a website indicates that your password is weak, add characters 
until it is strong. Be sure to read the recommendations on a website for creating a strong password 
whenever setting up a new online account.  

Tip #5 - Change your password every few months. Put yourself on a schedule for updating and 
recreating your passwords. 

Tip #6 - Create passwords that you will remember. If you think you will have trouble remembering them, 
write them down and keep them in a safe place.  

Tip #7 - Do not enter your passwords into your phone. Someone might steal your phone, or you might 
lose it.  

Tip #8 - Do not type your passwords in a public place. People might look over your shoulder as you type 
in your passwords. Additionally, if you are in a public place that offers free Internet access, such as a 
coffee shop, people using the same wireless connection might be able to see your passwords as you 
type them into a website. 

Identity theft is when private information, such as your name or Social Security number, is stolen and 
used without permission, usually to commit financial fraud. Identity thieves often use cyberspace to find 
and steal identities, because a great deal of information is available on the Web. Identity thieves gather 
available information from social media accounts and other public sites, and they find ways to trick 
people into revealing even more information. Identity thieves can be very clever. Three ways thieves use 
the Internet to steal private information include phone calls, phishing, and public computers.  

Thieves may contact us by phone, pretending to work for legitimate companies or institutions that we 
trust. Since our trust in them has already been established, it does not seem suspicious that they are 
asking for private information, such as account passwords, Social Security numbers, or home addresses. 
Identity thieves may also pretend to be a friend or acquaintance in order to obtain private data.  

When thieves send out emails that ask for private information, it is known as phishing. The emails may 
state that you have won a prize and that in order to claim your winnings, you must provide specific 

Paragraph 1

2

3

4

5

6

7

8

9
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Figure 7.5 A, Page 1

Lesson 7.5Working with a Table of Contents
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private information. Other email phishing scams include thieves posing as a service provider or a 
credible company. The emails say there is a problem with your account and that in order to resolve it, 
you must give them some private data or click on a link contained in the body of the email. Once you do, 
malicious viruses can be downloaded to your computer which can steal information stored on your 
computer. They may also record keystrokes you make while typing in banking or credit card logins and 
passwords. 

If a person uses a public computer and leaves without signing out of private accounts, anyone using the 
computer next will have full access to that person’s private information. This is why it is important that 
you always log out of your private accounts when you are finished using them. 

There are many tools in place to help consumers deal with identity theft, but the first step is to tell your 
parents or guardians. If you are worried that private information about yourself may be available 
publicly, it’s important to report it right away so that your identity can be protected. If identity theft 
goes undetected, thieves can use stolen information for a long time, creating long-lasting problems. 

13

14

Figure 7.5 A, Page 2

Lesson 7.5 Working with a Table of Contents
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Password Power 
Passwords are like locks that keep our private information safe. Email, social networks, and some gaming 
websites all use passwords to help protect our private data. Without a strong password, private 
information can be easy for thieves to steal. There are websites to help you generate strong passwords, 
such as strongpasswordgenerator.com. You should also follow some tips for creating stronger passwords. 

Eight Tips 
Tip #1 - Do not use any self-identifying facts. Never use your full name, birth date, or address. 

Tip #2 - Avoid using obvious facts about yourself. Never use information that would be easy to guess, 
such as your nickname or your pet’s name.  

Tip #3 - Make passwords of at least eight characters. However, follow the instructions on a website for 
password length. Some websites may require passwords longer than eight characters. 

Tip #4 - Include a combination of numbers, symbols, and letters. This will make your passwords as unique 
as possible. Some websites require this combination of characters. Websites may also tell you whether a 
password is weak or strong. If a website indicates that your password is weak, add characters until it is 
strong. Be sure to read the recommendations on a website for creating a strong password whenever 
setting up a new online account.  

Figure 7.5 B, Page 1
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Tip #5 - Change your password every few months. Put yourself on a schedule for updating and recreating 
your passwords. 

Tip #6 - Create passwords that you will remember. If you think you will have trouble remembering them, 
write them down and keep them in a safe place.  

Tip #7 - Do not enter your passwords into your phone. Someone might steal your phone, or you might 
lose it.  

Tip #8 - Do not type your passwords in a public place. People might look over your shoulder as you type 
in your passwords. Additionally, if you are in a public place that offers free Internet access, such as a coffee 
shop, people using the same wireless connection might be able to see your passwords as you type them 
into a website. 

Identity Theft 
Identity theft is when private information, such as your name or Social Security number, is stolen and used 
without permission, usually to commit financial fraud. Identity thieves often use cyberspace to find and 
steal identities, because a great deal of information is available on the Web. Identity thieves gather 
available information from social media accounts and other public sites, and they find ways to trick people 
into revealing even more information. Identity thieves can be very clever. Three ways thieves use the 
Internet to steal private information include phone calls, phishing, and public computers.  

Phone Calls 
Thieves may contact us by phone, pretending to work for legitimate companies or institutions that we 
trust. Since our trust in them has already been established, it does not seem suspicious that they are 
asking for private information, such as account passwords, Social Security numbers, or home addresses. 
Identity thieves may also pretend to be a friend or acquaintance in order to obtain private data.  

Phishing 
When thieves send out emails that ask for private information, it is known as phishing. The emails may 
state that you have won a prize and that in order to claim your winnings, you must provide specific private 
information. Other email phishing scams include thieves posing as a service provider or a credible 
company. The emails say there is a problem with your account and that in order to resolve it, you must 
give them some private data or click on a link contained in the body of the email. Once you do, malicious 
viruses can be downloaded to your computer which can steal information stored on your computer. They 
may also record keystrokes you make while typing in banking or credit card logins and passwords. 

Public Computers 
If a person uses a public computer and leaves without signing out of private accounts, anyone using the 
computer next will have full access to that person’s private information. This is why it is important that 
you always log out of your private accounts when you are finished using them. 

There are many tools in place to help consumers deal with identity theft, but the first step is to tell your 
parents or guardians. If you are worried that private information about yourself may be available publicly, 
it’s important to report it right away so that your identity can be protected. If identity theft goes 
undetected, thieves can use stolen information for a long time, creating long-lasting problems. 

Figure 7.5 B, Page 2
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Edit Citation: 
Use this drop-down 
menu option to update 
in-text citations with 
page numbers.

Insert Citation: 
Use this drop-down menu to credit a 
source of information by citing the book, 
article, or other source it comes from.

Style: 
Use the drop-down menu to choose the citation 
style of your document, such as MLA Style.

Bibliography: 
Use this icon to insert a list of all 
your sources in a bibliography or 
Works Cited section.

Manage Sources: 
Use this icon to edit sources and placeholders 
being used in your document.

Custom Table of Contents: 
Use this option to customize the format of a table 
of contents, including the font and style used for 
each section, as well as how page numbers appear. 

Lesson 7.6

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Skills
�� Create and modify 
bibliography citation 
sources

�� Insert citations for 
bibliographies

�� Insert bibliographies

�� Customize tables of 
contents

Part 7: Using Headers, Footers & References 

Protect Yourself 2
Working with Citations

Lesson Overview
When writing a research paper, it is important to properly credit the sources 
you use. Using Microsoft Word 2019, you can automatically credit a source in 
your document by citing the book, article, website, or other form of material 
you used. Once a source is added, if the same source needs to be cited later 
in the document, it can easily be inserted from a drop-down list. Word can 
also build the bibliography page in the correct format for you. Although 
there are several formatting styles for citing sources, one of the most 
common is MLA style. An MLA style report includes in-text citations after 
quoted or paraphrased passages, as well as a Works Cited page. 

In this lesson, you will edit a research paper about passwords and identity theft 
with in-text citations and create a Works Cited page of books used for research.
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1.	 Launch Word 2019 and open the file named 7.5 Protect Yourself from your My 
Word Projects folder on your hard drive or network drive.

2.	 Save the file as 7.6 Protect Yourself 2 in your My Word Projects folder on your 
hard drive or network drive.

3.	 Move your cursor to the end of the paragraph titled [Password Power].

4.	 From the References tab, Citations & Bibliography group, do the following: 

a.	 From the Style drop-down menu, select MLA.

b.	 From the Insert Citation drop-down menu, select Add New Source....

c.	 In the Create Source dialog box, select Type of Source as Book, then enter 
the following information in the appropriate fields, leaving all other fields 
blank (as shown below):

i.	 Author: Lisa Mulka

ii.	 Title: Cyber Literacy for the Digital Age

iii.	 Year: 2014

iv.	 City: Warwick

v.	 Publisher: B.E. Publishing

d.	 Click OK.

5.	 Click the citation (Mulka) that has just been inserted to select it.

6.	 From the Citation Options shortcut, select Edit Citation and do the following:

a.	 In the Add Pages field, enter [54], then click OK.

7.	 Move your cursor to the end of the paragraph titled [Tip #8].

4c.

4.

4a.

4b.

6.

6a.

Working with CitationsLesson 7.6

Instructions
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8.	 From the References tab, Citations & Bibliography group, do the following:

a.	 From the Insert Citation drop-down menu, select Add New Placeholder....

b.	 Key the text [googleappsbook] as your placeholder name, then click OK.

9.	 Move your cursor to the end of the paragraph titled [Identity Theft].

10.	 From the References tab, Citations & Bibliography group, Insert Citation drop-
down menu, do the following: 

a.	 Click the Mulka, Lisa source shown in the drop-down menu.

11.	 Click the citation (Mulka) that has just been inserted to select it.

12.	 From the Citation shortcut, select Edit Citation and do the following:

a.	 In the Add Pages field, enter [50], then click OK.

13.	 From the References tab, Citations & Bibliography group, do the following:

a.	 Click Manage Sources.

b.	 In the Source Manager dialog box, select [googleappsbook] from the 
Current List, then click Edit (as shown below):

10a.

8.

8a.

8b.

Lesson 7.6Working with Citations
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c.	 In the Edit Source dialog box, select Type of Source as Book, then enter 
the following information in the appropriate fields, leaving all other fields 
blank (as shown below):

i.	 Author: Courtney Snyder

ii.	 Title: Google Apps for Learning Digital Citizenship

iii.	 Year: 2017

iv.	 City: Warwick

v.	 Publisher: B.E. Publishing

d.	 Click OK.

e.	 Click Close.

14.	 Move your cursor to the end of the document and hit the Enter key.

15.	 On the first line of page 3, from the References tab, Citations & Bibliography 
group, do the following: 

a.	 From the Bibliography drop-down menu, select Works Cited.

16.	 From the References tab, Table of Contents group, do the following:

a.	 From the Table of Contents drop-down menu, select Custom Table of 
Contents….

b.	 In the Table of Contents dialog box, choose Simple from the Formats 
drop-down menu.

c.	 Click Right align page numbers and select the dotted Tab leader, then 
click OK.

d.	 Click Yes to Replace this table of contents?.

17.	 Proofread your document for accuracy and format, then resave the file.

18.	 Print preview. Your document should look similar to Figure 7.6, Pages 1-3.

19.	 Print or share the document if required by your instructor.

16a.

16b.

16c.

16d.

15a.

16. 15.
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Password Power 
Passwords are like locks that keep our private information safe. Email, social networks, and some gaming 
websites all use passwords to help protect our private data. Without a strong password, private 
information can be easy for thieves to steal. There are websites to help you generate strong passwords, 
such as strongpasswordgenerator.com. You should also follow some tips for creating stronger passwords. 
(Mulka 54) 

Eight Tips 
Tip #1 - Do not use any self-identifying facts. Never use your full name, birth date, or address. 

Tip #2 - Avoid using obvious facts about yourself. Never use information that would be easy to guess, 
such as your nickname or your pet’s name.  

Tip #3 - Make passwords of at least eight characters. However, follow the instructions on a website for 
password length. Some websites may require passwords longer than eight characters. 

Tip #4 - Include a combination of numbers, symbols, and letters. This will make your passwords as unique 
as possible. Some websites require this combination of characters. Websites may also tell you whether a 
password is weak or strong. If a website indicates that your password is weak, add characters until it is 
strong. Be sure to read the recommendations on a website for creating a strong password whenever 
setting up a new online account.  

Figure 7.6, Page 1
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Tip #5 - Change your password every few months. Put yourself on a schedule for updating and recreating 
your passwords. 

Tip #6 - Create passwords that you will remember. If you think you will have trouble remembering them, 
write them down and keep them in a safe place.  

Tip #7 - Do not enter your passwords into your phone. Someone might steal your phone, or you might 
lose it.  

Tip #8 - Do not type your passwords in a public place. People might look over your shoulder as you type 
in your passwords. Additionally, if you are in a public place that offers free Internet access, such as a coffee 
shop, people using the same wireless connection might be able to see your passwords as you type them 
into a website. (Snyder) 

Identity Theft 
Identity theft is when private information, such as your name or Social Security number, is stolen and used 
without permission, usually to commit financial fraud. Identity thieves often use cyberspace to find and 
steal identities, because a great deal of information is available on the Web. Identity thieves gather 
available information from social media accounts and other public sites, and they find ways to trick people 
into revealing even more information. Identity thieves can be very clever. Three ways thieves use the 
Internet to steal private information include phone calls, phishing, and public computers. (Mulka 50) 

Phone Calls 
Thieves may contact us by phone, pretending to work for legitimate companies or institutions that we 
trust. Since our trust in them has already been established, it does not seem suspicious that they are 
asking for private information, such as account passwords, Social Security numbers, or home addresses. 
Identity thieves may also pretend to be a friend or acquaintance in order to obtain private data.  

Phishing 
When thieves send out emails that ask for private information, it is known as phishing. The emails may 
state that you have won a prize and that in order to claim your winnings, you must provide specific private 
information. Other email phishing scams include thieves posing as a service provider or a credible 
company. The emails say there is a problem with your account and that in order to resolve it, you must 
give them some private data or click on a link contained in the body of the email. Once you do, malicious 
viruses can be downloaded to your computer which can steal information stored on your computer. They 
may also record keystrokes you make while typing in banking or credit card logins and passwords. 

Public Computers 
If a person uses a public computer and leaves without signing out of private accounts, anyone using the 
computer next will have full access to that person’s private information. This is why it is important that 
you always log out of your private accounts when you are finished using them. 

There are many tools in place to help consumers deal with identity theft, but the first step is to tell your 
parents or guardians. If you are worried that private information about yourself may be available publicly, 
it’s important to report it right away so that your identity can be protected. If identity theft goes 
undetected, thieves can use stolen information for a long time, creating long-lasting problems. 

Figure 7.6, Page 2
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Pens: 
Use this group to select the type of pen to use for drawing 
ink on the page. Choose the thickness, color, and effect 
from the pen’s drop-down menu. 

Ink to Shape: 
Use this icon to quickly convert ink drawings into 
shapes. Click the icon again when you are done 
using it to deactivate the tool.

Page Size: 
Use this drop-down menu to choose a paper 
size for the document. 

Draw/Draw with Touch: 
Use this icon to select a tool that allows you 
to draw with your finger, mouse, or stylus pen, 
depending on the device you are using. Click 
the icon again when you are done using it to 
deactivate the tool.

Eraser: 
Use this icon to erase ink that has been drawn 
on the page. Click the icon again when you are 
done using it to deactivate the tool.

Ink Replay: 
Use this icon to replay the sequence of ink 
strokes it took to create a drawing.

Lesson 8.13

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Skills
�� Set up document pages

�� Draw using digital ink

�� Use Ink to Shape

Part 8: Working with Graphics and Visual Elements 

Thank You Card
Using Digital Ink

Lesson Overview
Using shapes and pictures can be a creative way to enhance a document, but 
drawing something by hand can be an even more personal way to express 
yourself. Users with touch devices need only their finger or digital pens to 
create drawings in Microsoft Word 2019. Once you’ve created your drawing 
using any of the built-in pen effects, you can resize and modify your creation 
like any other object in Word. With Ink to Shape, gestures can even be turned 
into simple shapes like squares or circles. If a touch screen is not available, you 
can use your mouse and click and drag to write or draw on a document using 
digital ink.

In this lesson, you will create a hand-drawn thank you note using digital ink.
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3.

1.	 Using Word 2019, create a new Blank document.

2.	 Save the file as 8.13 Thank You Card in your My Word Projects folder on your 
hard drive or network drive.

3.	 From the Layout tab, Page Setup group, do the following:

a.	 From the Size drop-down menu, click More Paper Sizes….

b.	 In the Page Setup dialog box, Paper tab, Paper size: drop-down menu, 
select Custom size.

c.	 Enter a width of 7” and a height of 5”.

d.	 Click OK.

4.	 Adjust the margins to Narrow.

5.	 Insert a Fill: Blue, Accent color 1; Shadow WordArt with the text [To the BEST 
Teacher in the Galaxy…].

6.	 Change the font size of the WordArt to 28, apply the Transform, Inflate: Top 
text effect, and Align Center the WordArt.

7.	 From the Draw tab (shown below), do the following to draw a message:

a.	 From the Tools group, select Draw or Draw with Touch.

 Note: The option available depends on the device being used. If 
necessary, turn on the Draw tab by right clicking on the ribbon and 
selecting Customize the Ribbon….

b.	 From the Pens group, Pen: Galaxy 1 mm drop-down menu, click the plus 
sign (+) to increase the thickness two times.

c.	 Use your finger, digital pen, or mouse to draw the message [Thanks!] in 
the middle of the page.

d.	 From the Tools group, select Eraser.

e.	 Click on each stroke of the drawing you created to erase it.

f.	 Use the same pen to draw the message [Thank You!], then click Draw or 
Draw with Touch again to deactivate the tool.

 Hint: Draw the message without pausing to create a single object.

3a.

7b.

Using Digital InkLesson 8.13

Instructions

3b.
3c.

3d.
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Lesson 8.13Using Digital Ink

8.	 From the Draw tab, Convert group, do the following:

a.	 Click Ink to Shape.

b.	 Draw a rectangle and notice that Word converts your drawing to a shape, 
then click Ink to Shape again to deselect the tool.

9.	 Change the shape fill to none.

10.	 Change the size of the rectangle to 4 inches high by 6 inches wide.

11.	 Align Middle and Align Center the rectangle so that it creates a border on the 
page.

12.	 Resize and Align Center your drawing so that it fits below the WordArt and 
within the rectangle. 

 Note: If necessary, group the individual elements of your message to create 
one object.

 Note: If necessary, adjust the placement of the WordArt similar to Figure 8.13.

13.	 From the Draw tab, Replay group, click Ink Replay to see a video of the 
message being created.

14.	 Proofread your document for accuracy and format, then resave the file.

15.	 Print Preview. Your document should look similar to Figure 8.13.

16.	 Print or share the document if required by your instructor.

8. 13.
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Figure 8.13
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AutoSave:
Use this feature to save your file automatically as you 
work.

Version History:
Use this feature to review previous 
versions of the document that have 
been generated.

Open version:
Use this feature to open a previous 
version of an AutoSaved document 
with the option to restore it.

Lesson 9.6 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Quizzes for this part.

Skills
�� Using AutoSave

�� Using Version History

Part 9: Sharing and Working Collaboratively 

Top 10 Customers 
Working with AutoSave

Lesson Overview
Users of cloud applications have become accustomed to files saving 
automatically. Subscribers to Office 365 can now enable AutoSave so that 
any documents saved to OneDrive are updated as changes are made. While 
AutoSave can be very convenient, it is important to be thoughtful about 
how this might impact your file management. If you want to preserve an 
original copy of a file before making changes, be sure to use Save a Copy. If 
you ever do need to view an older version of the file, Version History can be 
used to review how the file has evolved, identify text that was lost, or restore 
a previous version of the file. As a default, new versions are generated every 
10 minutes, however AutoSave will continuously save the file as you make 
changes. And remember, AutoSave is only available for documents saved to 
OneDrive.

In this lesson, you will AutoSave a letter to a colleague, then use Version History 
to recover information that was deleted.

In order to complete this lesson, access to a lesson resource file is required 
and should be provided by your instructor.
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4a.

Working with AutoSave Lesson 9.6

1.	 Launch Word 2019 and open the file named Lesson 9.6 SOURCE. 

2.	 Save the file to the folder named My Online Word Projects on your OneDrive. 
Name the file 9.6 Top 10 Customers.

3.	 Notice that AutoSave is automatically turned on at the top  
of the ribbon.

4.	 To change how often AutoSave creates a new version of the file, do the 
following:

a.	 From the File tab, select Options.

b.	 In the Word Options dialog box, Save section, change the AutoSave 
recovery time to 1 minute (as shown below):

c.	 Click OK.

Instructions
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6.

12.

8.

Lesson 9.6 Working with AutoSave

5.	 Make the following changes to the document:

a.	 Change the font of the document, not including the table, to Times New 
Roman and the font size to 12.

b.	 Change the spacing of the document, not including the table, to single 
with no spacing before or after paragraphs.

c.	 Set the top margin to 2”.

d.	 Delete the phone number column.

e.	 Insert a column to the left of the table labeled [Rank:], then fill in the 
ranks 1 through 10.

f.	 Apply the Grid Table 4 - Accent 1 table style.

g.	 Bold the text [Winter Wonderland Thank You Card].

6.	 Click the Saved drop-down menu next to the name of the document at the top 
of the ribbon and select Version History.

7.	 In the Version History task pane, review the various versions of the file that 
have been AutoSaved.

8.	 Click Open version to open the first saved version of the document.

9.	 Copy the phone number column, then close the window.

10.	 Paste the copied column to the right of the table.

11.	 AutoFit the table by contents, then horizontally center the table.

12.	 Close the Version History task Pane.

13.	 Proofread your document for accuracy and format, then resave the file.

14.	 Print preview. Your document should look similar to Figure 9.6.

15.	 Print or share the document if required by your instructor.
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Dear Caroline, 
 
With the end of the year approaching, I thought it would be a good idea to send thank you notes 
to our best customers. The notes could be a good way to increase our brand awareness and the 
loyalty of our customers. Our Etsy reviewers say they love our company’s personal touch! 
 
Here is a list of the contact information of our top 10 customers of the year: 
 

Rank: Name: Address: Email Address: Phone: 
1 Silas Harrison 4201 Ritter St. 

Athens, AL 35611 
sharrison@email.com 256-233-9211 

2 Evan Frazier 2463 Smith St. 
Mansfield, MA 02048 

frazev@email.com 508-851-7328 

3 Riley Wolfe 4041 Big Elm 
Strasburg, MO 64090 

riley2008@email.com 816-865-2818 

4 Shayna Guerra 4715 Peck Ct. 
Santa Ana, CA 92705 

guerrafam@email.com 949-579-8085 

5 Rebecca Camacho 714 Neville St. 
Terre Haute, IN 47807 

r.camacho@email.com 812-638-3788 

6 Ava Tucker 2582 Duck Creek Rd. 
Danforth, ME 04424 

ava@email.com 650-903-9824 

7 Evie Barton 3484 Summit Ave. 
Southfield, MI 48075 

ebarton@email.com 248-927-0289 

8 Susanna McGee 1281 Honeysuckle Rd. 
Redmond, WA 98052 

suzymcgee@email.com 360-500-2876 

9 Chance Welch 677 Washington St. 
Houston, TX 77032 

welch.ch@email.com 832-814-8562 

10 Lucy Mann 2022 Yorkshire Rd. 
Kinston, NC 28501 

admin@email.com 252-268-0080 

 
Please use our Winter Wonderland Thank You Card (item #TH-13) to send personalized 
notes to these customers. 
 
Thanks, 
 
 
 
Tara 

Figure 9.6
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